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Document Conventions
There are several conventions that are used throughout this document to indicate actions to be taken or to 
highlight important information. The conventions are as follows:

Item
 

Meaning

View Perimeter a command name or a file that you are to select

Tools > Options a command path that you are to select – usually from the pull-down 
menus

Document Name the name of a document that is not hyper linked

Emphasis style used when referring to important word or phrases

Hyperlink style used when you have a direct link to another document on the web

Key in entering data with the keyboard

Quote style used to indicate an external source quotation

Note: text information about a command or process that you should pay 
particular attention to

1. Numbered Steps actions that you are to perform as part of the lab activities

<D> or Data press the data button on the mouse

<R> or Reset press the reset button on the mouse

<T> or Tentative press the tentative button on the mouse
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Chapter 1 - Getting Started with 
Bentley XM

Objective: The goal of this first chapter is to present all the information needed to 1) begin a new design 
project in XM, and 2) migrate a project from the Bentley 2004 software to the XM version.

Introduction
CDOT encourages all new design projects and project in the early part of the design phase to use MicroStation 
and InRoads XM. Additionally, the CDOT V04.00.00 Workspace environment has been developed to support 
the XM version of the software. The CDOT V04.00.00 Configuration has been released to run on MicroStation 
V8 XM 08.09.04.88 and Bentley InRoads XM Edition V08.09.02.16 and later. The upgrade to MicroStation 
XM did not require any major changes to the CDOT Standards; however, enhancements, modifications, and 
bug fixes have been completed with this upgrade.

This chapter is broken into three sections: 1) Starting a New Project in XM, 2) Migrating a Project from 2004 
to XM, and 3) Enhancements and What’s New. In addition to the instruction found in this document, many of 
the standard CDOT workflows have been updated to work with the CDOT V04.00.00 workspace. Use the 
workflow links in this document to access more detailed information contained in the workflows.

Important! The location of the resources for the CDOT configuration has changed as 
shown below.

Starting a New Project in XM
Creating New Projects in XM
An updated project creation utility is available to generate projects for XM. Use the Project 
Creation Utility to setup the initial directory structure for your new project. Locate and run the 
Project Creation Utility, ProjectCreationUtility.exe, by browsing to 
C:\Workspace\Workspace-CDOT_XM\Standards-Global\MicroStation\exes\. See the 
workflow CDOT Project Creation and PCF File Management.pdf for additional 
information on how to use this program to create a project and modify the project configuration 
file (PCF) for a network location or folder share.

http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20Project%20Creation%20and%20PCF%20File%20Management.pdf
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Setting Up InRoads for New Projects
A new registry file has been added as an InRoads resource to help users locate project specific 
files for use in InRoads. This file automates the process for setting project defaults and should 
be used for both new projects and project migrating from InRoads 2004. To take advantage of 
the functionality of the new registry file, follow the instructions in the document CDOT 
InRoads XM Project Defaults Management.pdf.

Migrating a Project from 2004 to XM
Migrating an Existing PCF to XM
The first step to convert a current V8 2004 project to XM is to upgrade your PCF. This will add 
the project to the Projects list in the MicroStation Manager dialog box and will ensure the 
project references will be found. The following step will demonstrate the changes that should 
be made. Project number 12345 will be used for this example.

1. Copy your project configuration file (12345.pcf) from the directory C:\Program 
Files\Workspace-CDOT\Standards-Local\Projects\ and paste it to C:\Workspace\Work-
space-CDOT_XM\Standards-Local\Projects\

2. Open the 12345.pcf file with Notepad from C:\Workspace\Workspace-CDOT_XM\Stan-
dards-Local\Projects\

3. Locate the variable CDOT_WKSP within the text of the 12345.pcf file as shown below.

http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20InRoads%20XM%20Project%20Defaults%20Management.pdf
http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20InRoads%20XM%20Project%20Defaults%20Management.pdf
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4. Change the path of this variable to; C:/Workspace/Workspace-CDOT_XM/

5. Save the changes to the file by choosing File>Save and then Close notepad.

6. Launch MicroStation and at the MicroStation Manager dialog box your project will be 
available from the Project pull down.
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Updating Levels for XM
MicroStation XM has been modified with a new interface and added functionality. Existing 
MicroStation V8 2004.dgn files will not have to go through any kind of conversions in order to 
update them to MicroStation XM. The exception would be if the dgn file needs any existing 
levels updated. Steps to do this can be found in the CDOT Level Update for V04.00.00.pdf 
workflow file.

Migrating Existing InRoads Project Data
A new registry file has been added as an InRoads resource to help users locate project specific 
files for use in InRoads. This file automates the process for setting project defaults and should 
be used for both new projects and project migrating from InRoads 2004.

Project Defaults
The document CDOT InRoads XM Project Defaults Management.pdf has been created 
specifically for CDOT’s implementation of InRoads XM. Refer to this workflow for more 
information on how to use preconfigured InRoads default settings to locate project specific 
InRoads files and how to manage the data file that controls these settings.

Migrating Existing InRoads Project Data
Existing dtm and alg files from past projects can be used without any translation when 
migrating existing projects from InRoads 8.5 to InRoads 8.9 (XM). However, once the files 
have been edited in InRoads XM, they will require a translation to be opened in InRoads 8.5.

All other InRoads files will need to be created from scratch. Several new CDOT standards have 
been developed to help with this effort. As an example, the new template library includes 
several predefined components and end conditions to facilitate the creation of cross sections.

Enhancements/What’s New
New Interface
MicroStation XM has a new interface. A detailed description of the new and enhanced interface 
features will be included in a MicroStation XM document that will be available mid February. 
Highlights of the new interface include: 

• Enhanced Button Assignments
• CDOT Tool Box - An icon has been added to the CDOT Tool Box so the user can get the 

active angle for 3 pts. 
• Getting Help - A pull-down menu has been added to the CDOT MicroStation XM 

interface enabling users to select a comprehensive selection of CDOT help tools. These 
include CDOT internal links to the CDOT Home Page, CADD Manual, Workflow 
manuals, and Request and Support.

http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20Level%20Update%20for%20V04.00.00.pdf
http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20InRoads%20XM%20Project%20Defaults%20Management.pdf
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Annotation Scale with References
MicroStation XM has enhanced the use of the annotation scale located in the model properties 
to control the size of linestyles in addition to text elements. This new capability helps alleviate 
some of the tedious efforts with changing your project scale of your sheet files. There is a new 
setting in the Reference Manager to verify that will ensure that your reference displays as 
intended.

1. Open Reference Manager

2. Double click on the reference name to bring up the Attachment Settings

3. The new setting is called Global LineStyle Scale. By default it is set to Master, which is ok 
for files that the annotation scale to control the linestyle scales.
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4. Select the pull down and change this to None. The toggle None is appropriate for drawings 
that have hard coded the linestyle scale to the elements. CDOT files that do this are the Sur-
vey files. On all survey referenced files the Global LineStyle Scale will have to be changed 
to None in the Attachment Settings.

5. Select Ok to close the Attachment Settings and close Reference Manager. Your linestyles 
will display as expected.

Changes to InRoads
There are several changes to the InRoads environment that impact the current CDOT 
workspace. These include: changes to the InRoads file formats, a new preference file format, 
and new template and roadway library formats. 

File Formats
The file format for InRoads data files has changed as noted in the following table:

2004 
Format

XM 
Format

Preference file .ini .xin
Surface file .dtm .dtm
Alignment file .alg .alg
Template file .tml .itl
Roadway Definition file .rwl .ird
Reporting .dba .xml
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Users will notice three major changes related to the change in file formats:

• Templates are now component based. 
• Modeling is real time 

• dba reports have been replaced with xml reports.

New Preference File
The InRoads V8 preference and style files (civil.ini and wysiwy.ini) have been replaced with a 
single XML formatted file with an XIN extension. This file also replaces the Survey FXP and 
FWF files. The new file is called CDOT_Civil.xin and is located here; 
C:\Workspace\Workspace-CDOT_XM\Standards-Global\InRoads\Preferences

New Template Library
The InRoads 8.5 Template Library (CDOT-Typical Sections.tml) has been replaced with an 
InRoads Template Library, ITL. The new file is called CDOT_Template-Library.itl and is 
located in C:\Workspace\Workspace-CDOT_XM\Standards-Global\InRoads\Templates. The 
new ITL file contains the Point Name List (TC names), Templates, Sections – Pavement, 
Sections – End Conditions and Components. These sections of the ITL file are organized in an 
explore view and contain several folder to categorize the template components.

Roadway Designer
The InRoads 8.5 Roadway Library (*.rwl) has been replaced with an InRoads Roadway 
Designer, IRD, file. The new Roadway Designer is a complete corridor design tool that allows 
you to run iterative design without generating InRoads files.   In Designer you can manage the 
corridor, template drops, point controls, end condition expressions, display references, 
secondary alignments, key stations, and superelevation. Additional design tools are available to 
aid in vertical gore design and curve widening to name a few.

New Plotting Solutions
The plotting features inside MicroStation XM have been updated in order to take advantage of 
the many changes to the print engine and graphics display subsystem. The plotting upgrades 
include enhancements that benefit direct printing, Batch Print, and PDF Composer. 
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Printer Drivers
Printer drivers control plotting devices, plot sizes, etc. The file extension for printer drivers has 
changed from *. plt to *.pltcfg. Changes have been made to the printer driver configuration 
files enabling them to be edited using the Printer Driver Configuration Editor inside 
MicroStation. This editing interface is easier to use and understand. The new interface creates a 
XML format file

Refer to the following workflows for instructions on how to adjust printer drivers and how to 
use them for general and specialized printing.

• CDOT MicroStation Printing.pdf
• CDOT Batch Printing.pdf
• CDOT Printer Driver Adjustments.pdf
• CDOT Shaded Color And Grayscale Printing.pdf

Pen Tables
MicroStation pen table’s process pen weights, colors, fill, and shading, etc. Upgrades to the pen 
tables have been completed to insure changes and upgrades to the CDOT Configuration print 
properly.

Survey Workflow Change
The Annotation Scale setting in the Model Properties is a new enhancement in XM and cannot 
be used in the Survey workflow because of limitation with InRoads Survey.  InRoads Survey 
will not apply the Annotation Scale to cells and requires additional Styles to be created for text 
to control the many justification options.  The decision to not implement the Annotation Scale 
setting was made since the process was broken and wouldn’t improve the multiple scale dgn 
output.

Since Survey uses the 3D-Seed_CDOT.dgn seed file to generate your dgns, a setting will have 
to be changed to display Survey graphics correctly in MicroStation XM. Please follow the 
following steps;

1. Open the Model Properties in MicroStation.

http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20MicroStation%20Printing.pdf
http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20Batch%20Printing.pdf
http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20Printer%20Driver%20Adjustments.pdf
http://www.dot.state.co.us/DesignSupport/CADD%20and%20Engineering%20Innovation/Workflows/V8%20XM/CDOT%20Shaded%20Color%20And%20Grayscale%20Printing.pdf
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2. Change the Line Style Scale: settings to Global Line Style Scale and verify the value is set 
to 1.0

3. Click OK to close the Model Properties dialog box.

4. Generate your graphics with the Survey Options for Line Scale: set to the output scale you 
creating.

Summary: If you experience any problems after using these instruction to get a new project running under 
in XM environment or the project you migrated from 2004 is not working properly, please 
contact the CDOT CADD Manager for assistance. 

mailto:CADDManager@dot.state.co.us
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Objective: The purpose of the remaining chapters of this guide is to explain the 
changes and additions that users should notice in MicroStation XM. These chapters should 
function as quick reference material to users questions regarding the new MicroStation XM 
environment. See the document Practical Guide for Using InRoads XM for details on the 
changes that have occurred to the InRoads software and design environment.

The distribution folder on the local computer XM has changed for MicroStation. The new 
directory structure conforms to the standard Windows operating system. The new default 
directory structure enables Bentley to release Select updates without MicroStation needing to 
be uninstalled and reinstalled.

Working Directory
Default location of Bentley Program files and Documentation.

• C:\Program Files\Bentley\Documentation
• C:\Program Files\Bentley\MicroStation

CDOT Data Paths
Location of application data and Workspace Standards resources

• C:\Workspace\Workspace-CDOT_XM\Standards-Global

Location of Interfaces, Projects, and Users

• C:\Workspace\Workspace-CDOT_XM\Standards-Local

User Data Paths
Location of the CDOT Preferences

• C:\Workspace\Workspace-CDOT_XM\Standards-Local\Prefs

Location of the CDOT AccuDraw shortcuts, Button Menu, and Function Key Menu

• C:\Workspace\Workspace-CDOT_XM\Standards-Local\Users
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MicroStation Manager
The default look for MicroStation Manager is the Windows Style dialog. The new Windows 
functionality in MicroStation Manager enables the user to right click files for shortcut fly outs, 
easy folder navigation, and quickly create sub folders. The familiar Bentley pull-down menus 
and workspace settings are still accessible, just in new locations.
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Bentley New File

The New File icon  located in the upper right hand corner of the MicroStation Manager 
dialog will open the ‘New’ dialog which allows creation of a new file using the active seed file. 
The active seed file can be changed by selecting the Browse icon.

Bentley Tools / File History

The Bentley Tools / File History icon    located in the upper right-hand corner of the 
MicroStation Manager dialog lists the most recently opened files. It also provides tools to 
Compress and Upgrade files. 

Set Default Seed File
A new tool in the Bentley Tools list is the Set default seed file. The Set default seed file tool 
opens a dialog which gives the user control on which seed file is defined when new 
MicroStation files are created in Windows Explorer by the File > New > MicroStation DGN 
File or by Right clicking in the explorer pane and selecting New > MicroStation DGN File 
from the short cut list.
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The Set default seed file can also be accessed by selecting;  
Start> All Programs > Bentley > MicroStation V8 XM > Set Seed File

Set Default Seed File Options include: 

Ask me to pick the seed file each time - will open the New dialog so the user can select 
the appropriate file. By checking the Launch Windows Explorer check box will open Windows 
Explorer.

Use MicroStation current seed file – will create the file in window explorer using the 
current seed file defined by the last used seed file or workspace variables

Use the seed file selected from this dialog – lets the user define the seed file from the 
browser section in the dialog. The current seed file as shown in the dialog.

Bentley Directory History

The Bentley Directory History icon    located in the upper right-hand corner of the 
MicroStation Manager dialog provides a list of previously opened directories. From the 
directory icon, the options for New, Copy, Compress, and Upgrade to V8 were removed. 
Creating a new or copying a directory can still be accomplished in the Windows style dialog, 
however to compress or upgrade a directory the option, Use Windows File Open Dialogs, 
needs to be checked off under the Look and Feel category in the Workspace Preferences dialog.
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MicroStation Manager Classic Style
To view the MicroStation Manager classic style, press the Shift and Esc keys prior to selecting 
the File > Close or File > Open commands. Permanently disable Windows style dialog with the 
option ‘Use Windows File Open Dialogs’ checked off under the Look and Feel category in the 
Workspace Preferences dialog.
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Chapter 3 - MicroStation XM 
Graphics Environment

MicroStation Interface
The MicroStation Design Interface contains a variety of tool command icons, toggles, dialog boxes, pull-
down menus, and various information displays. Most of these interface tools and options will be discussed in 
this chapter as well as others. 

The MicroStation Design Interface contains a variety of tool command icons, toggles, dialog boxes, pull-down 
menus, and various information displays. Most of these interface tools and options will be discussed in this 
chapter as well as others. 
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Primary Tools Tool Box

PopSet

The PopSet   tool works differently in XM. When PopSet icon enabled, the Tool 
Settings window will automatically hide itself when moving the cursor within the buffer area 
around the dialog. The buffer area is defined in PopSet Properties which can be accessed by 
<R> the PopSet button and selecting Properties from the fly-out menu.FM_BD_BodyIndent

 

PopSet is enabled if the icon is green. It is disabled if the icon is red.
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Element Information

The Element Information  dialog box has been redesigned and has additional ways for 
editing element information. Information displayed varies depending on the type of element(s) 
selected. If multiple elements are selected the elements will be listed in the top section 
Selection tree.

Element properties can be edited from this dialog by selecting the field and either Key-in the 
new value or select from a drop-down menu.

Right clicking in the dialog will bring up the Show/Hide shortcut menu to control the display of 
available tabs.
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Attributes Tool Box
The Attributes toolbar controls the element symbology prior to placement. Functionality 
highlights include:

Element Template  works similar to Settings Manager by defining level, color, style, 
weight, and type of element being placed. If the Element Template lock is enabled, any change 
to the Element Template will globally update elements placed using that template. 

Main Tool Frame - 2004 Edition
The 2004 Edition Main Tool Frame has been supplemented with a Task Navigation Tool Box

Main Tool Box
The Main tool box includes the tools that will in some manner manipulate current elements. 
The numbers next to each icon represents the positional keyboard mapping assigned to each 
icon. Each icon has a child toolbar that can be ripped from the parent toolbar except for the 
Element Selection [1] and Delete [8] icons.

XM Edition
Main Tool Box

XM Edition
Task Navigation Tool Box
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If you have the default function key menu loaded F3 will place the Main fly-out on your cursor.

Task Navigation Tool Frame
The Task toolbar has been added to include the primary creation tools for elements, text, 
dimensions etc. The purpose of the task tool bar is to be customized in such a way that it 
encourages a general workflow. Different Task lists can be displayed by selecting the Task 
button on the toolbar.

Task-based Interface
When using Task Navigation think “Workflow”. By default the Tasks are in a grouping of 
tools that are similar. The order of the tools can be customized to follow a specific 
workflow or general progression of work.

The Task List  icon opens the task list. Selecting a tool group from the list will 
display the associated commands for the selected tool group.

The Page Up and Page Down keys will quickly page through the Task Navigation tools.
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If you have the default function key menu loaded F4 will place the Task Navigation Fly-out 
on your cursor.

Use the Fly-out menu option Open as Toolbox to display a Fly-out tool box.

Positional Keyboard Mapping
Positional Keyboard mapping allows access to tools through the keyboard. The three main 
toolbars that are defined with positional keyboard mapping are the Main, Task Navigation and 
Tool Settings dialog. Each tool has a zone on the keyboard assigned to it. For example, the 
Main tool box uses numbers 1-8 across the top of the keyboard.
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Main tool box
The Main tool box has keyboard numbers assigned to it. Pressing a number is the same as 
selecting tools from icons. For numbers 2-7, a Fly-out list will appear on your cursor showing 
the additional tools from that child toolbox, either select the tool with the cursor or continue 
utilizing the keyboard mapping.
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 Task Navigation 
Task Navigation has the left side of the keyboard assigned to it. Pressing a letter will 
accomplish the same thing as selecting an icon. By pressing a letter, a Fly-out list will appear 
on the cursor showing the additional tools from that child toolbox. A tool can be selected with 
the cursor or by continuing to utilize the keyboard mapping.

Status Bar

The Status bar has added one new section to display if the Design History  has been 
initialized. By selecting the Design History icon in the status bar you can initialize it.

Also there is a new look to the Home  section of the status bar. The status bar will display 
one of four options depending on which dialog has focus.

The Home section of the status bar will display one of four options depending on which dialog 
has focus.
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 Home allows use of the positional keyboard mapping.

 Tool Settings dialog has input focus.

 AccuDraw dialog has input focus.

 Key-in Browser has input focus.

Additional Keyboard Focus
Escape – will take you to the Home position in the Status Bar

Enter – will open the Key-in Browser at your cursor

Spacebar – will change the focus to the AccuDraw dialog

Tab – will cycle elements that overlap (use instead of right click)

Page Up – move up in the Task Navigation tool box tree

Page Down – move down in the Task Navigation tool box tree

F9 – will open the key-in browser at your cursor.

F10 – change focus to Tool Settings window

F11 – will change the focus to the AccuDraw dialog.

F12 – will take you to the Home position in the status bar

Tool Settings Window
Many tools in MicroStation offer several different options that can be utilized to achieve a 
specific way elements are created or modified. These various tool options are located in a 
special dialog box, referred to as a window (Tool Settings window).

The Tool Setting window has the right side of the keyboard assigned to it. Pressing a letter will 
accomplish the same thing as selecting an option in the dialog. To see which letters are 
assigned to the Tool Settings window select the Escape key and the letters will temporarily 
appear.

Main things to remember regarding the Tool Settings window are:

• The Tool Settings window can be moved or relocated anywhere on or outside the 
MicroStation application window by left-click and dragging on the title bar.

• The Tool Settings window can be docked along the side of the application window.
• To display the options for a specific tool, simply click on the tool and the Tool Settings 

window will automatically display the specific options available for that tool. 
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• If there are no additional options available for a specific tool, the Tool Settings window 
will still be displayed, showing just the active tool in the title bar.

Mouse Mechanics
See the CDOT workflow document CDOT Mouse Clicks in MicroStation XM for information 
on changes and enhancements.

Drawing File Enhancements
Design File Settings
The Working Units category in the DGN File Settings dialog has a new layout and includes the 
coordinate readout settings.

Drawing Scale
A Drawing Scale dialog has been added to the pull-down menu at 
Settings > Drawing Scale. This dialog can docked into the top or bottom of the 
MicroStation application window.



Migrating CDOT Projects & MicroStation XM Update Guide   Page 35

Chapter 3 - MicroStation XM Graphics Environment

Tool Enhancements
Place Line
The place line tool includes a solution option when placing a line using the perpendicular or 
tangent snap. A second solution will be shown as a dotted shaded line.

Pressing the ALT key will toggle between available solutions.

Place Arc
• Method: placement of arcs has been expanded from the two choices of Center and Edge. 

Now the placement can be done in different orders Start, Center or Center, Start. The 
Edge placement options include Start, Mid, End or Start, End, Mid.

• Direction: An option for constraining the direction of arc from Clockwise (CW) or 
Counter Clockwise (CCW).

• Solution: Similar to the place line tool enhancement, there is an option for displaying 
multiple solutions when using the perpendicular or tangent snap. 
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Cells
Place Cell Index
The Place Cell Index will create a display of the cells that are attached to the current model. 
The Index layout will be stored in the current model file with the cells being referenced in. 
If cells are deleted or added to the cell library the index will not automatically be updated 
to show those changes. In that situation the cell index will need to be created.
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Place Active Cell
New options have been added to the Tool Settings dialog for placing cells.

Mirror – at placement options include Horizontal, Vertical, and Both.

Interactive – at placement options include Rotate and Scale, Rotate Only and Scale Only.

Scale Multi-line Offsets – at placement the active scale is applied to multi-line offsets.

Scale Dimension Values – at placement the active scale is applied to dimension values.

Scale Annotations – at placement the active scale is applied to elements that use 
annotation scale.

AccuDraw
Shortcut Key-ins
HA – “AccuDraw on Hold” will remove the AccuDraw compass for one data point. 
HS – “AccuSnap Toggle” will toggle off or on AccuSnap; replaces J. 
HU – “AccuSnap Suspend” will suspend AccuSnap for one time command; replaces U. 
RE – “Rotate Element” will rotate the AccuDraw compass to an element that is identified. 
RV – “Rotate View” will put the view into dynamic rotation mode.
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Settings
Operation: Auto Focus Fields will change the focus and lock the field when the shortcut 
key-ins A, and D are used.

Display: Added option for compass fill and dialog size. In addition, an option exists to 
display coordinate values on the cursor during placement.
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Manipulate
Scale
The Scale Tool Settings dialog has added new features and has been reorganized. The 
About Element Center check box has been moved from the expanded 

Construct Array Along Path
The method Along Path has been added to the Construct Array tool. This method has 
different ways of accomplishing this by Distance, Number, or Both.

Number – defines the number of items placed along a path.

Distance – defines the distance between items placed along a path.
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Both – defines both the number and distance of elements placed along the path.

 

Stretch
The Stretch command has been added to the Manipulate tool box as an individual tool. If a 
fence does not exist in the drawing the place fence tool automatically is initiated.
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Move to Contact
Move to Contact has been added to the manipulate tool box as a means of moving 
individual or a selection of elements to another element. This tool was added to help 
manipulate elements in 3D designs but can be applied in 2D designs as well.

Before:

After:

Modify
Break Element
The Break Element tool will break the element at the identified location.
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Element Selection
Element Selection tool has been incorporated into PowerSelector. Additional options include 
Disable Handles and Select Handles which allow multiple elements in a selection set to be 
modified by their handles.

• <D> nothing in the view will clear the selection set.
• Ctrl + <D> will add elements to a selection.
• <D> + drag will create an inside block mode.
• Ctrl + Shift + <D> + drag will switch to overlap block mode.
• <D> <D> will switch to the active block mode in the dialog.
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Positional Keyboard mapping for Element selection are YUIOP and HJKL;

Handles
Handles have added functionality that help with editing a number of element types. In addition 
to references, reference clip boundaries, and named fences.

Handle Display
Toggling the display of element handles is done by selecting the button on the lower right 
side of the Element Selection Tool Settings dialog.

Alternate Handles
Alternate handles displayed as filled circles can be seen with certain elements such as Text. 
With the alternate handles modifications such as text wrapping can be accomplished.

Move

1. Select the elements.

2. Place the cursor over a selected element, not a handle.

3. <D> + drag the elements to the new location and let go.
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Copy

1. Select the elements.

2. Place the cursor over a selected element, not a handle.

3. <D> + drag the elements to the new location.

4. As you drag press and hold the Ctrl key an icon plus sign will appear next 
to the cursor indicating the elements will be copied.

5. When you are at the location to place the copied elements, release the 
<D> button

Modify
When an element or elements are selected the handle or handles can be selected by holding 
the Ctrl key and when the elements are modified the geometric relationship is maintained.

Alternate Modify
To modify handles and not keep the geometric relationship hit the Alt key once to toggle 
off geometric relationship.
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Fences
Copy/Move Fence Contents
Copy Fence Contents to New File tool was added to the Fence toolbar. This icon replaces the 
key-ins “Fence File” and “Fence Separate” which will copy and move the contents of a fence to 
a new drawing.

Saved Fences
Saved Fences have been added to the expand section of Tool Settings window for the place 
fence tool. A saved fence allows the user to recall and managed different fences in one 
drawing. 

Measuring
The measuring tool has added a new long awaited feature. The new Mode options now include 
True, View, and AccuDraw/ACS. These options will allow measurements to be View/
Horizontal or True/Slope measurements.
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Element Information

The Element Information  dialog box has been redesigned and has additional ways for 
editing element information. Information displayed varies depending what type of element is 
selected. If multiple elements are selected the elements will be listed in the top section 
Selection tree.

 

Element properties can be edited from this dialog by selecting the field and either Key-in the 
new value or select from the drop-down menu.

Right clicking in the dialog will bring up the Show/Hide shortcut menu to control the display of 
available tabs.

Quick Info
This dialog will display the element level and symbology. To access the dialog hover your 
cursor over the element, hold down the Alt key, then <R> right click.
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Analyze Element
The original Analyze Element dialog can be accessed using the Key-in  
“analyze element”.
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Text
Inserting Symbols 
The Word Processor dialog has a new drop-down list for selecting symbols such as Degree, 
Centerline, and Fractions.

To add symbols to the drop-down list, click on the Symbol icon. 

• The Symbols dialog will appear.
• Select the character you want to add to the list and select the Insert icon.
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To manage a list of symbols select the Manage Favorite List icon. The Manage Favorite List 
dialog will appear with options to sort, rename, and delete symbols from the list.

Superscript and Subscript
From the Word Processor dialog box two new buttons are added for placing Superscript and 
Subscript text. Toggle on one of the scripts then type in the text in the Word Processor dialog. 
Text placed will be smaller and the justification will be adjusted.
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Text Fields
Text fields can be inserted through the Word Processor dialog. Fields are values that are 
specific to an element or design file. Values such as the length and direction of a line can be 
input. Modifying the element will automatically update the text field with the new value.

When inserting the text field, select the format for display using the Active Settings or user 
defined values.
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Edit Text and Data Fields
While using the Element Selection tool you can double click to edit text. Double clicking a data 
field in the Word Processor dialog will open the Edit Enter Data Field dialog. This can be used 
to modify the value, number of spaces, and justification of the Data Field.

Spell Checker
Spell Checker now works with text that was placed using the Place Note command.
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Models
Model Properties
Models now include an attribute for defining a Line Style Scale. This is defined as a Property 
of the model similar to Annotation Scale for text in version V8. Changing the Line Style Scale 
will resize linestyles in the active model.
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Cells
Annotation Scale
Cells can utilize the Annotation scale setting that is defined as a property of the model. This is 
an expansion of the setting used by Text and Dimensions. When changing the model annotation 
scale factor, the cells placed with annotation scale on will be resized.

Note: The cell annotation factor only applies to cells placed with Annotation Scale toggled 
on at time of cell placement

Attachment of Cell Libraries
Attaching an entire folder of cells can be accomplished from the Cell Library dialog pull-down 
File > Attach Folder.
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Enhanced References Dialog

Open in New Session – was added to the Tools pull-down and the shortcut Fly-out menus 
to open the selected reference file in a new session of MicroStation.

Rotation – view and modify the rotation of a reference.

Offset – view and modify the difference in Global Origins.

Treat Attachment as Element for Manipulation – when this option is enabled, it will 
allow the use of standard Manipulate tools with references, such as Move, Copy, and Rotate. 
The pull-down and pop-up menu options are still available from the Reference File dialog.

New Level Display – controls the view display for new levels that are created in a reference 
file. The three options are to use the Configuration Variable definition, Always On, or Never 
On.

Move Boundary with Reference – when this option is enabled in the Move Reference 
command it will allow the reference clip boundary to remain stationary allowing only the 
reference file to be moved.

Reference File Types
Raster Reference file formats – new file formats include Adobe: PDF, I/RAS B such as 
CLR, LRD, MPF and RST, JPG 2000: JPG, Enhanced Compression Wavelet: ECW

Reference Set key-ins
Reference Set key-ins – new set of key-ins that can be used on reference files during a 
batch process for example enabling or disabling Display, Snap, Locate, and Treat As Element.
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Printing and Pen Tables
See the CDOT workflow document CDOT MicroStation Printing for printer driver and 
pen table settings

Print dialog box
Use Full Sheet

This check box is only available when a Windows printer driver is selected. When checked, 
the plot size can be expanded to the full dimensions of the selected paper size. It is up to the 
user to ensure that the plotted elements are within the physical plot limits of the printer. 
When unchecked the plot size is restricted to the physical plot limits of the printer. The plot 
limits vary from printer to printer, however the plot limits for most printers is to within a ¼ 
inch on each side of the selected paper size. For a typical 8 ½ x 11 inch sheet you would be 
restricted to a print area of 8 x 10 ½ inches.

Print Destination
This option is only available when a Windows printer driver is selected. For any Windows 
printer the user has three options:

Send to printer – sends plot directly to the selected printer (default)

Create plotfile – creates a plot file like the Bentley drivers
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Create metafile – creates a Windows Enhanced Metafile (.emf) 

Print Preferences
The Print Preferences dialog box includes a number of useful settings. Many of these 
settings were only available through configuration variables in previous versions of 
MicroStation. These settings are now maintained in the user preference file. Access this 
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dialog from the Print dialog pull-down menu by selecting; 
Settings > Preferences
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